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Print Queue Manager™ 

 

This document describes the installation and operation of Software Shelf® Print Queue Manager software.   

Software Version:   Version 3.0 

Operating System: Windows NT™, 2000, 2003, XP 

© 1999 Intrust Software, Los Angeles, CA.  

 The Software described in this document is owned by Intrust Software and Exclusively licensed worldwide to 
Software Shelf International, Inc. and is protected by United States copyright laws and international treaty 
provisions.  Therefore, you must treat the Software like any other copyrighted material (e.g. a book or musical 
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and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial 
Computer Software-Restricted Rights at 48 CFR 52.227-19 as applicable.   

Manufacturer is Software Shelf International, Inc., 702 Marshall Street, Suite 611, Redwood City, CA 94063 
USA. 

The following are trademarks owned by Software Shelf International, Inc.: 

Software Shelf 

Print Queue Manager 

Windows NT™ is a registered trademark owned by Microsoft Corporation 

All other trademarks are the property of their respective owners. 
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Introduction 
Print Queue Manager allows centralized control of all printing activity on a network of 
Windows NT™ Servers and Windows NT™, Windows 3.1, Windows 95, Unix, OS/2 or 
Apple Macintosh Workstations.  

Printers may be directly connected to a Windows NT™ Print Server via a COM port, LPT 
port or network-connected (either through a built-in network card or via a device which 
interfaces the network to an LPT1 style connector).  (This device is often called a “Printer 
Server” – do not confuse this with the Windows NT™ Print Server machine). 

 
Print Queue Manager gives you the power to: 

• Move or copy jobs between printers 

• Redirect and load-balance jobs based on criteria you control 

• Notify users of redirected jobs 

• Control multiple printers with the click of a button. 

• Arrange printers into logical groups, allowing you to perform actions on groups of 
printers that you select. 

• View print jobs from multiple printers, all in one view. 

• Make copies of existing printers with the click of a button. 

• Automatically add locate and track printers in a domain, or even in an entire network. 
 

You can also: 

• Colorize printers based on criteria you select.  Such as “Printers with error show up in 
red” 

• Sort printers based on criteria you select.  Such as “Order printers by document 
count”, so the busiest printers show up on top. 

Print Queue Manager components 

Print Queue Manager consists of two components, the client component which is a 
Windows NT™ application that runs on any Windows NT™ Server or Workstation on 
your network.   The server component runs on any Windows NT™ server that hosts 
printers.  The server component enables the Automated Printer Management (APM) 
features. 

 
BackOffice approval  

Print Queue Manager was written from the ground up as a native 32-bit NT application, 
and is BackOffice approved.  
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Getting Started 

Let’s get started by taking a look at the main Print Queue Manager Window, and 
examining its parts. 

The main Print Queue Manager window is comprised of two main elements; the “Printer 
List” on the left, and the “Document View” on the right. 

 

 

 

Printer List 

The Printer List is used for the selection and management of printers.  There are two 
different modes which you can use to select printers, either the through the PrintFolders 
tab, or through the Network tab. 

The PrintFolders tab allows grouping of printers into logical “folders” which you create. 
Printers can be sorted by their name, document count or status.  Clicking on a print folder 
allows you to perform actions on all printers in the folder, such as 
pausing/resuming/purging, etc.   
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The Network tab allows you to navigate directly to a printer in your network, and manage 
it. There are some features that may not always be accessible when using the Network 
tab. APM, for example, will only work in the network tab, if the printer is also in the 
PrintFolders tab. 

There is no need to install the printer first (as in Windows NT™).   

See: Using the PrintFolders View  

Document View 

The Document View shows all of the documents for the selected printer(s).  Documents 
can be paused, restarted, deleted, etc.  The Document View supports sorting by any of 
the columns, both ascending and descending.  The Document View also supports 
customizing the column layout, so you can drag-and-drop the columns into the order that 
you want them.   

See: Using the Document View. 
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Installation 
Installing Print Queue Manager 

Print Queue Manager is comprised of two components, the server and the client.   

Server Component 

The server component needs to be installed on any Print Server that you wish to add 
Print Queue Manager’s features to, such as moving jobs between printers, or any other 
APM feature. 

Client Component 

The client component can be installed on any Windows NT™ Workstation or Server.  
This is the main user interface where you will access the features of Print Queue 
Manager. 

For either installation, the process is quick and simple.  You need only to select the path 
where the product will be installed, and the shortcut group for the start-menu items.  It’s 
that easy. 

1) Insert the original CD-ROM into the appropriate drive in your Windows NT™ 4.0 
Server/Workstation. 

2) Setup should launch automatically once the CD is inserted. 

3) If it doesn’t, from the Windows NT™ Explorer File Manager, run the SETUP.EXE file 
on the CD. 

4) For the Setup Type, select the appropriate setup type:  

(a) Select Server Setup (Service Only) if this is a print server with printers you 
would like Print Queue Manager to control. 

(b) Select Client Setup (Administrator Only) if this is a workstation or a server 
from which you will be running the Print Queue Manager user interface. 

(c) Select Full Setup if this is a print server, and you will also be running the 
Print Queue Manager user interface from this machine. 

5) Follow the installation instructions that appear. 

6) After a short period of copying files, the program group is created and the installation 
is complete. 

7) Setup will only ask you to reboot if some of the files it needed to copy were in-use.  
Rebooting ensures that these files are properly copied into place. 

8) If the install does not tell you to reboot, then you can start using the product 
immediately. 
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Upgrading From Previous Versions 

Before upgrading, please be sure to uninstall any earlier version of Print Queue Manager, 
either beta or production.  You must uninstall previous versions before installing the new 
one. 

Note: Failure to reboot after de-installation can result in registry entries relating to an 
earlier version being left on your system, causing Print Queue Manager to function 
incorrectly.  See the Troubleshooting section if you suspect this may have occurred. 

Registering 

After installation be sure to register Print Queue Manager through our web site 
http://www.softwareshelf.com or call us at 650-369-5200.  This ensures you receive your 
free 90 days of Print Queue Manager technical support. 

Registry entries 

Installing Print Queue Manager on a clean system (no previous install of any version) will 
generate the following registry settings: 

HKEY_CURRENT_USER\Software\Intrust Software\Print Queue Manager 

HKEY_LOCAL_MACHINE\Software\Intrust Software\Print Queue Manager 
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Using Print Queue Manager 
Using the PrintFolders View 

The PrintFolders View is designed to allow you to organize your printers into logical 
groups for easier management and display. 

PrintFolders are useful because they allow you to view all of the jobs at one time, for a 
group of printers.   

Creating your own folders and adding printers to them is easy. All of the functions relating 
to the PrintFolders view can be accessed by right-clicking on an item (any item, folder, 
printer, etc).  To add a folder, right-click on an existing folder, or in the white space, and 
then click “Add-Folder”. 

Adding printers to a folder is also easy.  Simply right-click on the folder and then click 
“Add Printer To Folder”.  The Browse for Printer Dialog will be displayed.  The Browse for 
Printer Dialog is a fast easy way to add one or more printers to your folder.  Click the 
selection box to the left of a printer in order to select it, and then click OK.  You can select 
as many printers as you want from as many different domains/servers.  Adding all of the 
printers from an entire domain is simple, just click the domain, then click OK.  Print 
Queue Manager will automatically search for every server with shared printers, and add 
them to the print folder. Note: This may take a while if the domain has many printers. 

Do not confuse adding a printer to a folder, with “installing a printer”.  When you add a 
printer to a folder, you are really adding a “printer shortcut” to the folder, and not installing 
a new printer.  To install a new printer, use the printer menu) 

PrintFolders show the sum of the document counts for all of their printers.  This is useful, 
as you can collapse the print folder and show only the document count for each folder.  
When you select a print folder, its name appears on the top in the “Selection” area. 

TIP 

When Print Queue Manager runs for the first time, it will create a folder called “Local 
Printers”, and will automatically add every local printer to this folder. 

TIP 

You will notice when Print Queue Manager loads that it initializes the printers in the 
PrintFolders view in order of appearance.  While this initializing is in progress, you can 
still use Print Queue Manager.  Sorting is not performed until all printers have been 
initialized. 

Using the Network Tab 

The network tab allows you to browse directly to a server and manage a print queue 
without installing it.  For more robust management capabilities, use the PrintFolders tab. 

Using the Browse for Printer Dialog 

The Browse for Printer Dialog is used to add printers to a PrintFolder.  You can either 
type the printer name directly into the edit box at the top of the dialog, or browse to the 
printer.  You can select the entire network, a domain, a server or a specific printer.  When 
you select a network, domain or server, Print Queue Manager will automatically search 
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for all printers in that area.  See How to add all printers on a domain or a network to a 
folder for more information. 

Using the Document View 

The document view is used to view and control the documents that are in the printer or 
printers currently selected.  If a single printer is selected, the printer name will appear in 
the “Selection Bar”.  The document view will show the print jobs for that printer only.  If 
you are viewing multiple printers by selecting a PrintFolder, then the document view will 
display the jobs for all of the printers in the PrintFolder.  The printer column is useful in 
this scenario to show you which printer each job is related to. 

Multiple jobs can be selected at one time by drag-selecting in the document column or by 
using the shift/ctrl keys while clicking.  

The document view has several features that may not be readily apparent, these are: 

1. Columns are moveable, try dragging and dropping the columns into the order you 
want them to appear.   

2. Full sorting support, just click on the column.  You can also right-click and select Sort.  
Sorting is available for all columns. Each time you click on a column, the sort order 
will be reversed. For example, the first time you click on the “Owner” column, all 
documents will be sorted in ascending order, by owner. If you click on the “Owner” 
column a second time, the documents will be sorted in descending order. 

Customize Colors Dialog 

The customize colors dialog can be used to set the colors for both printers and 
PrintFolders.  For Printers, you can set colors for two criteria, either the document count 
or the error status. 

To set the color based on the document count for either a printer or folder, click on the 
color well button, and select the color you want to use, then click in the edit field and set 
the document limit.  When the document count exceeds the limit that you set, the 
printer/folder will turn the selected color. 

TIP 

Try setting the document count to 0. This will allow you to see which printers are active, 
and which printers are empty, based on their color. 

Note: Many printers do not report their error status properly, so setting the colors for the 
printer error state does not work with all printers.  This is due to the printer driver not 
properly reporting the error state to Windows. 
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How To… 
How to make a copy of a printer 

Right-Click on the printer you wish to copy and select “Install a copy of this printer”.  In 
the “Duplicate Printer Installation” dialog, enter the new printer name and the new share 
name.  You can also add any number of copies that you wish. 

When making more than one copy of a printer, Print Queue Manager will add a number 
to the end of each printer name. 

TIP 

Using the string “%d” in the printer name and share name will control where the 
sequence number is inserted.  For example, using the name “%d Copied Printer” will 
generate printer names: “1 Copied Printer”, “2 Copied Printer”, etc. 

How to Create and Delete PrintFolders 

Right-click on the PrintFolders view, and select “New Folder”.  The new folder will be 
added to the bottom of the PrintFolders view, and you will be able to edit the folder name. 

To delete a folder, right click on the folder and select “Delete Folder”.  You can also 
select the folder, and then press the Delete key. 

How To Add Printers To A PrintFolder 

Right click on the PrintFolders view, and select “New Folder”.  The new folder will be 
added to the bottom of the PrintFolders view, and you will be able to edit the folder name. 

To delete a printer, right click on the printer and select “Remove Printer From Folder”.  
You can also select the printer, then press the Delete key. 

How to add all printers on a domain or a network to a folder 

Right-Click the folder that you want to add the printers to, and then select “Add Printer to 
Folder”.  Navigate to the domain you want to add and click the selection checkbox.  You 
do not need to expand the domain, simply click the selection checkbox.  Print Queue 
Manager will then display a dialog while it locates all of the printers in the domain. 

How to operate on more than one printer at a time 

Selecting a folder which contains more than one printer allows you to operate on all the 
printers in the folder at once.  See the Printer Menu for information on which commands 
work on a folder. 

Tips on using PrintFolders 

You can directly edit the “DefaultGroups.ini” file.  This file contains the contents of the 
PrintFolders view. 

How to colorize the printers and folders in the PrintFolders View 

Right-click on the PrintFolders view, or click on the PrinterFolders menu, and select 
“Customize Colors”.  See the Customize Colors Dialog for more information. 
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How to reorder columns in the document view 

The columns in the Document View can be ordered by clicking on the columns and 
dragging them to new positions. 

How to add user tools to the menu 

Select the menu item “Tools->Customize User Tools”.  Use this dialog to add your own 
custom commands to the tools menu.  The menu items you add will be displayed in the 
Tools menu. 

How to customize the toolbar 

Select the menu item “Tools->Customize”.  Once in this dialog, you can drag and drop 
items on the Print Queue Manager window to new locations.  You can move menus to 
toolbars and vice-versa. 

How to copy documents from one printer to another 

Using Drag & Drop 

To copy multiple documents from one printer to another, first select the documents you 
would like to copy. 

While holding down the [Shift] key, drag the selected documents from the Document 
View, and then drop the documents on the destination printer in the PrintFolders View. 

Using Load Balancing 

See: How to load balance printers 

Using APM (Automated Printer Management) 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Click [Next] on the Introduction page. 

5. Click Enable APM for ALL new jobs, and then click [Next]. 

6. Click the Apply an action to all documents checkbox, and then click Copy to 
another printer. 

7. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 

Copy documents to several printers 

See: How to use print broadcasting  
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How to move documents from one printer to another 

Using Drag & Drop 

To move multiple documents from one printer to another, first select the documents you 
would like to move. 

Drag the selected documents from the Document View, and then drop the documents on 
the destination printer in the PrintFolders View. 

Using the Send To Printer… menu item 

1. From the Document View, select the documents that you would like to move to 
another printer. 

2. Click the Document menu, or right-click on any of the selected documents. 

3. Select the Send To Printer… menu item. 

4. From the Browse for Printer dialog box, select the printer that you would like the 
documents copied to. 

Using APM (Automated Printer Management) 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Click [Next] on the Introduction page. 

5. Click Enable APM for ALL new jobs, and then click [Next]. 

6. Click the Apply an action to all documents checkbox, and then click Move to 
another printer. 

7. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 

Move documents to several printers 

See: How to use print broadcasting  

Using Load Balancing 

See: How to load balance printers  
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How to use print broadcasting 

Print broadcasting is a term used to describe the process of printing a single document 
on several printers simultaneously.  

For example, a printer can be set up so whenever somebody prints a document, a copy 
of it would also go to the Records department printer for filing. 

Another use for print broadcasting is to speed up printing many copies of a single 
document. Lets say you need one thousand copies of a one-page document. This will 
take over 2 hours on your average 8ppm printer. Using print broadcasting, you can 
configure one printer to share this workload with several printers. For our example, let 
say you share the workload across 10 printers. You 2-hour task can now be 
accomplished in about 12 minutes. 

Configuring a print broadcast printer 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Click [Next] on the Introduction page. 

5. Click Enable APM for ALL new jobs, and then click [Next]. 

6. Click the Apply an action to all documents checkbox, click Copy to another 
printer, and then click [Next]. 

7. From the Select Destination Printer(s) page, click [Add]. 

8. From the Browse for Printer dialog box, select one or more destination printers. 
Each document printed to the source printer, will also print on each of the destination 
printers you select in this dialog box. 

9. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 
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How to load balance printers 

Load balancing is used to distribute the workload between two or more identical printers.  

The granularity of the workload distribution is per document. That is, a single document 
will be distributed to one printer or another, but will not be split up.  

Using APM, a printer can be configured to offload incoming documents to another printer 
whenever it is too busy. 

APM Load Balancing distributes documents based on a user specified threshold. For 
example, a printer might be configured to load balance to a second printer when the first 
printer had 3 or more documents already waiting to be printed.  

APM load balancing can also be configured redirect documents to a second printer only 
when the first printer is printing a large document that will take a long time. 

APM allows distribution between several print servers, whereas Windows NT™ print 
pooling only works between printers on the same print server. 

Using APM Load Balancing 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Click [Next] on the Introduction page. 

5. From the When to enable page, select Enable APM for load balancing, and then 
click [Next]. 

6. From the Load Balancing Options page, select the load balancing options that best 
suites your needs, and then click [Next]. 

7. From the Select Destination Printer(s) page, click [Add]. 

8. From the Browse for Printer dialog box, select a destination printer. When the load 
balancing conditions have been met, new documents will be redirected to the printer 
selected in this dialog box.  

9. NOTE: Although you can select multiple printers from the Browse for Printer dialog 
box, load balancing works best if each printer has only one destination printer. If 
multiple destination printers are selected, then load-balanced documents will be 
printed on each destination printer causing several copies to be printed. This has the 
same effect as print broadcasting. 

10. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 

Using Printer Pooling 

APM load balancing may be used in conjunction with Windows NT™ print pooling. 

See: Windows NT™ online help for more information.  
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How to get notified when a printer is down 

Using APM 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Click [Next] on the Introduction page. 

5. From the When to enable page, select Enable APM only when the printer is down 
or has an error, and then click [Next]. 

6. From the Select APM Action page, you may select an action, however it is not 
necessary if all you need is to be notified when the printer is down. Click [Next]. 

7. From the Notifications and Alerts page, select the appropriate notification options. 

8. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 
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How to redirect documents when a printer goes down, or has an error 

When a printer goes down, or has an error that prevents it from printing any further, APM 
can automatically move existing documents in the queue to a backup printer. APM will 
also redirect any new documents to the backup printer. The owners of the print job can 
optionally be notified that their document was printed on an alternate printer. 

Using APM to redirect documents from non-working printers, to working printers. 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Click [Next] on the Introduction page. 

5. From the When to enable page, select Enable APM only when the printer is down 
or has an error, and then click [Next]. 

6. Click the Apply an action to all documents checkbox, click Move to another 
printer, and then click [Next]. 

7. From the Select Destination Printer(s) page, click [Add]. 

8. From the Browse for Printer dialog box, select one destination printer. When the 
source printer goes down, all documents will be redirected to the printer you select 
from this Browse for Printer dialog box. Click [Next]. 

9. NOTE: Although you can select multiple printers from the Browse for Printer dialog 
box, this option works best if the source printer has only one destination (backup) 
printer. If multiple destination printers are selected, then documents will be redirected 
to each destination printer causing several copies to be printed. This has the same 
effect as print broadcasting. 

10. From the Notifications and Alerts page, select the appropriate notification options. 

11. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 
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Automated Printer Management (APM) Wizard  
Introduction 

Automated Printer Management (APM) automates tasks that would normally require 
human intervention. Tasks that can be automated include: 

• Rerouting documents from busy printers to less busy printers (load balancing) 

• Rerouting documents from printers that are down to working printers. 

• Being notified when a printer goes down or has an error. 

• Making copies of everything printed to one printer, on another printer. 

• Print Broadcasting 

• And more… 

To configure a printer to use APM 

1. Select a printer from the PrintFolders View. 

2. Click the Printer menu, or right-click the selected printer. 

3. Select the Automated Printer Management (APM)… menu item. 

4. Follow the remaining directions displayed by the Automated Print Management 
Wizard. 
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When to enable 

• Disable APM 

If this option is selected, APM will not 
be active for the specified printer.  

• Enable APM for all new jobs 

If this option is selected, APM will act on 
all documents in the queue (waiting to 
be printed). Furthermore, APM will act 
on all incoming documents, and will 
continue to do so until this option has 
been disabled. 

The action that is performed on each 
document is specified by your selection in the Select APM Action dialog box. 

• Enable APM only when the printer is down or has an error 

This feature works like the Enable APM for all new jobs feature, with the following 
exception. 

If this option is selected, APM will only act on documents after the printer goes down 
or has an error. Error conditions include: 

1. General Error 

2. Paper Jam 

3. Paper Out 

4. General Paper Problem 

5. Not Available 

6. No Toner 

7. User Intervention Required 

8. Out of Memory 

9. Door Open 

Note: APM depends on the notification sent by the printers in order to detect error 
conditions. Some printer manufactures do not report all error conditions; therefore, 
APM may not work correctly with these printers. 

• Enable APM for load balancing 

If this option is selected, APM will only act on documents after the criteria have been 
met, as specified in the Load Balancing Options dialog box. 

In order to see the Load Balancing Options dialog box, you must first select this 
option. 
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See: How to load balance printers  

Select APM Action 

The APM Action dialog box allows you to 
specify which action will be applied to 
each document. 

• Move to another printer 

This causes documents to be rerouted 
to another printer, as specified in the 
Select Destination Printer(s) dialog 
box. The document will then be 
printed on the selected destination 
printer, but will not be printed on the 
APM source printer. 

• Copy to another printer 

This causes documents to be copied to another printer, as specified in the Select 
Destination Printer(s) dialog box. The document will then be printed on the selected 
destination printer, as well as the APM source printer. Consequently, more than one 
copy of the document will be printed. 

• Delete documents 

This causes documents to be deleted before they are printed. 

• Pause documents 

This causes documents to be paused before they are printed. Documents must then 
be un-paused manually. 

Select Destination Printer(s) 

The Select Destination Printer(s) dialog 
box allows you to specify destination 
printers. Documents will be copied, or 
moved to the destination printers you select 

Add printers by clicking the [Add] button. 

Remove printers by selecting the printer 
from the list, then clicking the [Remove] 
button. 

NOTE: If multiple destination printers are 
selected, then documents will be copied or 
moved to each destination printer causing 
several copies to be printed. This has the same effect as print broadcasting. 

Load Balancing Options 
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The Load Balancing Options dialog box 
allows you to specify the criteria that APM 
will use for load balancing. 

See: How to load balance printers  

• More than          documents 

This option tells APM to reroute 
incoming documents only if the queue 
has more than the number of 
documents specified. Documents will be 
rerouted to the destination printer 
specified on the Select Destination 
Printer(s) page. 

For example, if 10 were entered into 
this field, APM would allow this printer to have up to 10 documents in the queue. 
When the 11th document is sent to this printer, APM would reroute it to the 
destination printer. 

• More than          bytes 

This option tells APM to reroute incoming documents only if the combined total bytes 
of all the documents in the queue, are more than the bytes specified. Documents will 
be rerouted to the destination printer specified on the Select Destination Printer(s) 
page. 

For example, if 10000 were entered into this field, APM would allow this printer to 
have any number of documents in the queue, as long as the total bytes in the queue 
did not exceed 10K. Whenever the queue has enough documents to total 10K or 
more, any new document sent to this printer, will be rerouted to the destination 
printer. 

• When the printer is down or has an error. 

If this option is selected, APM will reroute documents after the printer goes down or 
has an error. This is in addition to the other load balancing options displayed in this 
dialog box. 

Notifications and Alerts 

If APM reroutes a users document, APM 
can be configured to notify the user which 
printer the document has been rerouted to. 
This notification can be turned on for any 
action that APM takes, whether it is moving 
a document, pausing a document, or just 
notifying the user that the printer is down. 
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Confirmation 

The confirmation dialog box explains that actions APM will be taking when the [Finish] 
button is clicked. 
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Menus 
File Menu 

 

The file menu offers the following commands:  

 

Server 
Properties 

Shows properties for the local print server. 

 

Exit Closes the application 

 

View Menu 

 

The View menu offers the following commands: 

 

Toolbar Shows or hides the toolbar. 

 

Status 
Bar 

Shows or hides the status bar. 

 

Printer 
List 

Shows or hides the printer list view. 

 

Refresh Refreshes the information displayed by Print Queue 
Manager.  This is not normally necessary, as Print 
Queue Manager displays the latest data about all 
printers and jobs, as they change. 

 

PrintFolders Menu 

The PrintFolders menu offers the following commands, which provide you with the ability 
to control the PrintFolders view. 

 

New Folder Creates a folder. 

 

Rename Folder Change the name of a folder 
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Delete Folder Removes a folder. 

 

Add Printer to Folder Adds a shortcut to a printer to the 
selected folder. 

 

Remove Printer from 
Folder 

Removes the selected printer from the 
current folder. 

Sort Allows printers to be sorted by various 
criteria. 

 

Show Server Names Enables you to show or hide the server 
name for a given printer.  This is useful 
for lengthy server names, which obscure 
the name of the printer.. 

 

Customize Colors Allows color selection for printers based 
on various criteria, such as a large 
document count, printers with errors, etc. 

 

 

Printer Menu 

The Printer menu offers the following commands, which provide you with the ability to 
control one or more printers.  Most commands operate on both a single printer, or a print 
folder.  When a print folder is selected, the command will operate on all printers in the 
print folder.  Common commands also operate on both local and remote printers. 

 

Pause 
Printing 

Pauses the selected printer(s).  No jobs will print 
while a printer is paused.   

 

Support 

4 Multiple Printers 

4 PrintFolders 

4 Local and Remote Printers 
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Set As 
Default 

Sets the selected printer as the default printer. 

 

Support 

4 Single Printer 

4 Local Printer 

 

Purge Print 
Documents 

Deletes all print jobs in the selected printer 

 

Support 

4 Multiple Printers 

4 PrintFolders 

4 Local and Remote Printers 

 

Install copy 
of this 
printer 

Automatically installs one or more copies of the 
selected printer.  Works with a single printer.  
Works with local and remote printers.  The new 
printers will have the same settings as the 
selected printer.  The newly created printers will 
be automatically added to the currently selected 
print folder. 

 

Support 

4 Single Printer 

4 Local and Remote Printers 

 

Add Printer Install a new printer.  Installs the printer on the 
local machine only. 

 

Support 

4 Adds Local Printers only 

 

Delete 
Printer 

Deletes the selected printer (uninstalls it).  Note 
that this is different that removing a printer from a 
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print folder (PrintFolders only contain shortcuts to 
printers, not actual printers). 

 

Support 

4 Single Printers 

4 Local and Remote Printers 

 

Document 
Defaults 

Displays a property sheet which allows you to 
configure the defaults for all documents printed on 
this printer.  Supports local printers only. 

 

Support 

4 Single Printer 

4 Local Printer 

 

Properties Displays a property sheet which allows you to 
configure all settings related to the printer.   

 

Support 

4 Single Printer 

4 Local and Remote Printers.  (Note: Properties are 
read-only when working with a remote printer. 

 

Document Menu 

 

The Document menu offers the following commands, which provide you with the ability to 
control one or more print jobs. 

 

Pause Pauses the selected document or documents 

 

Resume Resumes the printing of the selected document 
or documents 
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Restart Restarts the printing of the selected document 
or documents 

 

Delete Deletes the selected document or documents 
from the printer 

 

Properties Allows configuration of certain job properties, 
including priority and job notification user. 

 

Sort Allows sorting of jobs in the document view by:  

4 Document Name 

4 Printer Name 

4 Status 

4 Page count 

4 Owner 

4 Time Submitted 

4 Job Number 

4 Priority 

4 Size 

 

Tools Menu 

 

The Tools menu offers the following commands, which provide you with the ability to 
customize the toolbars and menus: 

 

Customize Allows you to configure the buttons and 
menus.  Your settings will be saved and 
appear that way each time you load the 
program. 

 

Options Allows access to global options. 
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Customize User 
Tools 

Allows you to add up to nine customized 
tools to the tool menu.  Each tool can have 
it’s own name, EXE file, command line and 
starting folder.  This is useful for putting 
your various print related tools, so that they 
are easily accessible from Print Queue 
Manager.  The tools you add will be 
displayed at the bottom of the Tools menu. 

Help Menu 

The Help menu offers the following commands, which provide you with help: 

 

Help Topics Takes you to the help file. 

About Print Queue 
Manager 

Show you version information about 
this product and allows access to our 
support web sites. 
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Troubleshooting 
Print Queue Manager is too slow 

Print Queue Manager has many features that are specifically designed for performance.  
Print Queue Manager is designed to handle thousands of printers with thousands of print 
jobs, using little overhead, while delivering fast performance.  If you are experiencing 
slow-downs, you should try some of the following tips: 

1. Turn turning off advanced printer error detection, through Tools->Options. 

2. If it is related to a printer, try removing the printer and see if the problem goes away. 

3. Try turning off sorting in both the PrintFolders view and the Document View. 

If you are managing printers connected to a remote Windows NT™ server which is 
accessed through TCP/IP instead of NetBEUI, updates will be shown once every 7 
seconds. This is due to limitations of the Windows NT™ print spooler talking to servers 
through TCP/IP (usually the case in a heterogeneous network configured not to route 
Microsoft Networking packets). 

I am unable to move or copy jobs from one printer to another  

Make sure that the server component is installed on the print server.  

Make sure that the printers are attached to a Windows NT™ print server. 

Make sure that you are moving or copying documents between two similar printers. The 
source and destination printers should be using the same printer driver. 

Note: APM features may not be available on printers that are attached to non Windows 
NT™ print servers (such as Novell™ print servers). 

When a printer has an error, the error status is not displayed 

Many printers do not report their error status properly, so features based on the printer’s 
error state may not work correctly.  This is due to the printer driver not properly reporting 
the error state to Windows. To see if this is the case, compare that status shown by the 
user interface, with the status shown by the Windows NT™ Printer window. If neither 
status shows the error state, then the printer driver is at fault. 

Novell™ printers do not update automatically 

The Novell™ redirector does not support dynamic updates from Novell print shares. You 
can use the F5 button to refresh the display on demand. 
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Where to find technical support 
Software Shelf provides technical support for Print Queue Manager for 90 days after the 
product has been purchased. Our technical support desk can be reached by: 

 

Phone: 727-445-1920 

Fax: 727-445-9223 

Email: 

 

Support@softwareshelf.com 

Address: 

 

Software Shelf International, Inc. 

601 Cleveland Street 

Clearwater, FL 33755 

USA 
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